GTalarm2

Application Note: Automation

Monitoring, alarm, control, automation

This manual includes steps to install, set up and use your system.

Topkodas
Applications:

- Large pharmaceutical warehouses
- Hospitals
- Small-scale pharmacies and laboratories
- Small storage facilities

Monitoring solutions should incorporate a complete management system that includes the following features:

- User management;
- Sensor inventory management;
- Site calibration management;
- Reading the sensors, installed at every site;
- All sensors or tags clearly assigned to a specified location;
- Management of alarm set points;
- Directing alarm messages to specific individuals.
- Rapid tracking of system activities.

Features of the module GTalarm2

- 2G or 3G modem
- 4 Analog inputs (pull up 5.1K) 0-10V
- 2 Analog Input/Output 0-10V, 0-20mA
- 3 Digital Inputs/Outputs 3.3V, 20mA
- 4 PGM outputs 24V/1000mA, Open Drain
- Up to 32 sensors, temperature, humidity etc.
- * Digital expansion module BUS
- In-field firmware upgradeable via USB and SERA2 software
- Events log buffer, 2048 events
- Program remote controls using the master or installer codes
- Up to 800 users remote controls with mob phone
- Up to 800 users remote controls with iButton or RFID keycard
- Up to 800 user code. To control with Wiegand keyboard
- Built-in-real-time clock backup battery
- Unlimited control via SMS
- Push button software reset

*Bus terminal can be used as digital output. There is no expansion module function at the moment.

The meaning of icons in the manual:

- ! Very important
- i Important
- Book About the manual
Contents

1 Building monitoring, alarm system .................................................................4
  1.1 General view of the module...........................................................................5
  1.2 Meaning of LEDs and contacts.....................................................................5
  1.3 First steps to prepare GTalarm2 module and Sera2 software........................5
2 Power supply, Battery Wiring ..........................................................................6
3 Applications. Examples.........................................................................................6
  3.1 Single sensor control.....................................................................................6
  3.2 Heat and cool control loop............................................................................7
  3.3 Process Alarm................................................................................................7
  3.4 Temperature, humidity control......................................................................8
  3.5 Ventilation control.........................................................................................8
  3.6 Multiple sensors application. Smart house..................................................9
  3.7 How to control heating or cooling device with the module GTalarm2...........10
    3.7.1 How does smart thermostat, alarm system works?.................................10
    3.7.2 How to prevent the output from frequently changes according to minute temperature changes .................................................................11
    3.7.3 The example of heating, cooling control with the module GTalarm2 .....12
    3.7.4 Change the room temperature remotely via mobile, web app ...............13
    3.7.5 Change the room temperature with SMS text messages ....................13
4 Sensors. Inputs....................................................................................................15
  4.1 Steps to start humidity sensors DHT22/AM2305/AM2306/AM2320/AM2321 .15
    4.1.1 Humidity sensor watchdog .................................................................16
  4.2 Steps to start analog sensors, connected to the inputs 0-10V, 0-20mA, 4-20mA ..16
  4.3 Steps to start temperature sensors DS18b20...............................................17
  5 How to identify sensors, connected to the inputs?.............................................19
  6 Low and high alarm threshold settings, Output activation...............................20
  7 Every field explanation in Sera2> Automation/ Sensors window .....................21
  8 How to calibrate the sensor.............................................................................23
  9 How to convert Celsius to Kelvin or Celsius to Fahrenheit..........................23
 10 Outputs............................................................................................................24
 11 Power low alarms...........................................................................................25
 12 Alarm events such as open doors ....................................................................25
 13 Remote monitoring, control, configuring, FW updating over the internet .........25
 14 General system configuration ........................................................................25
 15 Logging events................................................................................................27
  15.1 Event monitoring.........................................................................................27
  15.2 Monitoring Inputs, outputs & general system info .....................................28
  15.3 Realtime Testing & Monitoring > Sensors/ Automation ...............................29
1 Building monitoring, alarm system

Automated data monitoring provides reliability advantages compared to manual measurements, which rely on human intervention. It could be used for measurement of the temperature and/or relative humidity distribution within a storage area, including identification of hot and cold spots. Temperature sensors should be located in areas where the greatest variability in temperature is expected to occur. Temperature, humidity sensors should be positioned so as to be minimally affected by transient events such as door opening. The advantage of the system: data recorded accurately and continuously.

Automation data monitoring system has the following technical characteristics:

- **Temperature**
- **Humidity**
- **Analog 0-10V**
- **Analog 4-20mA**

**Figure 1 The purpose of the module GTalarm2**

The advantages of the system:
- It is possible to connect up to 32 sensors for monitoring purpose.
- Low and high threshold for output activation. Cooler, heater or other device will be activated, before temperature goes out of range.
- Sensor calibration. Temperature, humidity measuring will be more accurate and stable over the selected range after sensor calibration.
- Celsius to Kelvin, Fahrenheit conversion.
- Event alarms such as mains power failure or door open. Operational events (for example door opening in freezer rooms and cold rooms) can have a significant impact on environmental control. Users can react earlier and the damage could be less if they will be informed about unwanted events.
- It is possible to connect to the module via Linux server. This system is user programmable and may also be remotely monitored and controlled via Linux server.
- Events log. Events may to be logged and recorded. Up to 2048 events could be logged to the system if more events needed, events could be logged via Linux server.
- Hysteresis.

**Figure 2 Hysteresis visualization**

- High and low alarm hysteresis. The module will not send events if the temperature fluctuates in defined temperature range.
- High and low hysteresis for output activation. The module will not activate / deactivate the temperature output, if the temperature fluctuates in defined temperature range.

**Figure 3 Sensors connection to the module GTalarm2**

Continuous collect and buffer data, even during power loss.

Various sensors: temperature sensors for ambient and refrigerated stores, sensors with remote probes for low temperatures, temperature and relative humidity sensors and sensors for logging events such as door opening.

Sensors could be calibrated manually.
1.1 General view of the module

- Micro SIM card holder of "Push-Push" type
- GSM antenna connector
- RESET button
- Mini USB programming connector
- REG (yellow) see table 3
- DATA (red) see table 3
- WDG (green) see table 3
- Power supply and input/output connector
- External microphone connector

Do not locate SIM card with force, because you may damage SIM card holder.

1.2 Meaning of LEDs and contacts

Table 1 Meaning of LEDs

<table>
<thead>
<tr>
<th>Name</th>
<th>Indication variations</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>WDG (green) built-in LED</td>
<td>Watchdog heart beat blinking, remains lit for 50ms, and turns off after 1000ms.</td>
<td>The module is functioning.</td>
</tr>
<tr>
<td>Off</td>
<td></td>
<td>The module is out of order or no voltage</td>
</tr>
<tr>
<td>REG (yellow) built-in LED</td>
<td>Lights continuously</td>
<td>Modem has been registered to the network.</td>
</tr>
<tr>
<td>Flashes, remains lit for 50ms, turns off for 300ms</td>
<td>Modem is being registered to the GSM network.</td>
<td></td>
</tr>
<tr>
<td>Blinking fast, remains lit for 50ms turns off for 50ms</td>
<td>PIN code of SIM card error. PIN code request should be removed</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td></td>
<td>Modem failed to register to the network.</td>
</tr>
<tr>
<td>DATA (red) built-in LED</td>
<td>Lights continuously</td>
<td>The memory of the module contains unsent reports to the user or to the server.</td>
</tr>
</tbody>
</table>

1.3 First steps to prepare GTalarm2 module and Sera2 software

**Preparation procedure of the module GTalarm2.**
- Connect the GSM antenna to the antenna connector.
- Insert the SIM card in the SIM card holder. Ensure that PIN request function is disabled.
- Connect the module to the computer via mini USB cable.

**Install configuration software SERA2.**
- Go to the http://topkodas.lt/ website and download SERA2 software.
- Open the folder containing installation of the software SERA2. Click the file „SERA2 setup.exe”
- If installation directory of the software is OK, press [Next]. If you would like to install the software in the other directory press [Change], specify other installation directory and then press "next".
- Check if the correct data are entered and press Install
- After successful installation of the software SERA2, press [Finish]

**Connection of the module to your PC**
- The module must be powered with (+12V >500 mA) voltage, it should have inserted SIM card (with replenished account and removed PIN CODE REQUEST). Module must be connected to the PC via micro USB cable

**Work with the software SERA2**
2 Power supply, Battery Wiring

It is possible to supply the security system from stabilized power supply source 10-15 V and not less than 1,5A. It is necessary to calculate max current of power supply. The current of the alarm system is the current used by sensors, relays, siren and other devices. It is most convenient to use power supply source applied for power supply of security systems with the option to connect backup lead battery. It is recommended to mount remote control relays into sockets. Sockets may be easily fixed in metal box. It is necessary to select relays according to preferred voltage and current.

Power supply application note: https://www.topkodas.lt/Downloads/GTalarm2_TPS12_AN_EN.pdf


Do not reverce the polarity

3 Applications. Examples.

There is several examples of applications with temperature sensor DS18b20 and temperature, humidity sensor AM2320. The same AM2320 sensor could measure temperature and humidity.

The DS18b20 digital thermometer provides 12-bit Celsius temperature measurements. The DS18b20 communicates over a 1-Wire Each DS18b20 has a unique 64-bit serial code, which allows multiple DS18B20s to function on the same 1-Wire bus. Thus, it is simple to use one to control many DS18b20s distributed over a large area. Applications that can benefit from this feature include HVAC environmental controls, temperature monitoring systems inside buildings, equipment, or machinery, and process monitoring and control systems.

Temperature and humidity combined sensor AM2320. It is digital temperature and humidity sensor is a digital signal output has been calibrated. Using special temperature and humidity acquisition technology, ensure that the product has a very high reliability and excellent long-term stability. Ultra-small size, low power consumption, signal transmission distance up to 20 meters, making all kinds of applications. Applications: HVAC, dehumidifiers, testing and inspection equipment, consumer goods, automation, data loggers, gas stations, home appliances, humidity control, medical, and other relevant humidity measurement and control.

3.1 Single sensor control

Input D1 on the module measures the temperature of a chamber or oven with a temperature sensor. Control loop takes feedback directly from the input D1 and signals output OUT1 on the module to switch the heater that heats the chamber or oven accordingly.

- The signal from the input is used as feedback to the control algorithm.
- The signal from the output controls the heater by signaling when the heater should be ON for ON – OFF control or how long it should be on.
- Enter names for inputs, outputs to make the application easier to understand.
- Sensors calibration possible

Figure 5 The meaning of icons

Each time after configuring the module press Write icon thus the software SERA2 will write configuration changes into the module!

After configuration of the module, all settings may be saved at PC. It enables to save time, when next time the same configuration will be used – it will not be necessary again to set the same parameters. If you want to save that is already recorded by the module, firstly you must read configuration of the module. Press Read icon. In order to save configuration go to File then press “Save As” or “Save”. Enter configuration parameter in the displayed table and press „OK”

In order to start saved configuration go to File then press Open

It allows to copy the same programmed content into as many modules as required.

Figure 6 Power supply connection

Figure 7 Single loop control
### 3.2 Heat and cool control loop

Input D1 on the module measures the temperature of a chamber with a temperature sensor. Control loop takes feedback directly from the input D1 and signals output OUT1 on the module to switch the heater that heats the chamber and OUT2 to cool the chamber as needed.

- The signal from the input D1 is used as feedback to the control algorithm.
- The signal from the OUT1 controls the heater by signaling when the heater should be ON for ON–OFF control or how long it should be on.
- The signal from OUT2 controls cooling by signaling, when the chiller should be ON.
- Enter names for inputs, outputs to make the application easier to understand.
- Sensors calibration is possible

![Figure 8 Heat and cool control loop](image)

### 3.3 Process Alarm

Input D1 on the module GTalarm2 measures the temperature of a chamber or oven with a temperature sensor. GTalarm2 monitors the temperature from the input D1, which is also used by the control loop as feedback for heat control. When the temperature goes out-side the normal range defined by the user-adjustable, alarm set points, OUT1 energizes an audible alarm and an indicator lamp to get the operator’s attention.

- The signal from Input D1 is the one the GTalarm2 monitors against the alarm set point.
- The signal to the output indicates when the alarm has occurred. The alarm message could be send to the user in case of temperature alarm whether or not there is an output attached.
- The output could drive external devices as shown in this example.
- Enter names for inputs, outputs to make the application easier to understand.
- Sensors calibration is possible
- If output activation in case of alarm events is needed, please configure required parameters in "Sensors/ Automation" window.

![Figure 9 Process Alarm](image)

If Indicator lamp and alarm buzzer is needed, please refer to the “Fire and Security system” application note.
3.4 Temperature, humidity control

The temperature and humidity of an environmental chamber are controlled by two loops. Loop1 uses a heater to increase the temperature and cooling coil to lower the temperature. Loop2 uses a solenoid to control water to flow to an atomizer to raise the humidity and a dehumidification coil to lower the humidity. To minimize wear on the compressor and use of electricity, the compressor is turned OFF and ON by the controller’s output for compressor control.

- The signals from the temperatures and humidity loops determine when the temperature, humidity loops need the compressor to be on.
- The signal from OUT signals when to turn on the compressor.
- To save power and extend the life of the compressor, it is desirable for the compressor to be off when it is not needed. The need for the compressor is anticipated by monitoring the inputs.
- Delay times could be set.
- Enter names for inputs, outputs to make the application easier to understand.
- Sensors calibration is possible.
- Set the hysteresis parameters long enough to protect the compressor from too much cycling, but short enough to allow the compressor to turn OFF between uses.

![Figure 10 Temperature, humidity control](image)

3.5 Ventilation control

The kitchen ventilation requirement is based on the intensity of the use of the equipment (the cooking equipment is never all at once in the ‘cooking mode’).

The module GTalarm2 was designed to be on one automatic, continuous and extremely smooth way respond to current situations without human intervention and to be applicable in all possible ways business scenarios in kitchens.

- When the kitchen is not in operation, the module GTalarm2stop the ventilation or to continue with a low capacity to maintain good hygiene during inactivity. The fans and control valves are automatically set to the minimum air flow settings.
- When the unit in on operation, the module GTalarm turns on the ventilation. The control valves and fans are set to the maximum air flow settings. The control valves and fans could be controlled depending on temperature or humidity sensor’s values.
HVAC control. Switch from min to max airflow

Temperature and humidity sensor. The same sensor can measure temperature and humidity. It is possible connect up to 3 temperature-humidity sensors to the D1, D2, D3 inputs.

The house ventilation requirement is based on the intensity of the use of the equipment. The module GTalarm2 was designed to be on one automatic, continuous and extremely smooth way respond to current situations without human intervention and to be applicable in all possible ways scenarios in the house.

- When the kitchen is not in operation, the module GTalarm2 stop the ventilation or to continue with a low capacity to maintain good hygiene during inactivity. The fans and control valves are automatically set to the minimum airflow settings.
- When the unit in on operation, the module GTalarm2 turns on the ventilation. The control valves and fans are set to the maximum airflow settings.
- The control valves and fans could be controlled depending on temperature or humidity sensor’s values.

3.6 Multiple sensors application. Smart house.

Up to 32 sensors could be connected to the module GTalarm2.

Up to 32 temperature sensors could be connected to the same input.

Up to 3 temperature-humidity sensors could be connected to D1, D2, D3 inputs.

Up to 6 outputs could be used for device control purpose.

Multiple temperature sensors. It is possible to connect up to 32 temperature sensors to the module GTalarm2.

Temperature-humidity sensor. The same sensor can measure temperature and humidity.

PIR movement detection sensor.

Magnetic contact.

0-10V voltage sensor

4-20mA current sensor.

Heating control. It is possible to switch ON or OFF heating device.

HVAC control. It is possible to switch HVAC to minimum or maximum airflow.

Barrier control. It is possible control the barrier up or down from mobile phone.

Garage door control. It is possible control the garage door up or down from mobile phone.
Various types of sensors could be used with the module GTalarm2. It is possible to connect to the module GTalarm2 on any web-enabled device to see your sensor data, set alarms, customize text alerts, etc. Types of sensors:

- The Temperature and Humidity Sensor is used to measure atmospheric temperature and humidity in indoor environments. Useful in server and clean rooms, humidors, museums, industrial spaces, greenhouses, and heating and ventilation applications.
- The Temperature (Thermistor) is used to measure temperature in freezers, HVAC units, on pipes and in liquids.
- The Motion Detection Sensor is used to detect movement within a specific area. Motion detection sensors are frequently used in security and energy management applications, among others.
- The Dry Contact Sensor is used to detect the opening of a door. Useful in warehouses, real estate, cottages, second homes.
- The 4-20ma current sensor is used to measure the current in sensors, probes or other devices.
- The 0-10 volt sensor is used to accurately measure charge - or voltage - for up to 10 Volts across two wires. Useful for measuring output from a variety of sensors, probes and devices.

It is possible to control devices, connected to the outputs of the module GTalarm2. For example:

- Set the HVAC system to the minimum or maximum airflow.
- Control automatic gates.
- Turn ON or OFF heating device.

### 3.7 How to control heating or cooling device with the module GTalarm2

#### 3.7.1 How does smart thermostat, alarm system works?

The module will keep the home at a stable temperature

**Figure 11** The controller will turn ON/ OFF heater, depending of the temperature

„Min Value To Activate Output“ temperature is great for helping prevent home from going below certain temperatures by turning on heating when the set limits are reached. Turn off the heating, when comfort zone is reached.

The smartphone will alert user if there are unusual temperature changes at home.

**Figure 12** The controller will send alarm SMS and call to the user if the temperature will reach alarm value

„Min Value Alarm“ temperature can prevent the pipes from freezing, even if the heating system is broken. The module GTalarm2 will inform the user (send alarm SMS and call).

Temperature control system relies upon a controller, which accepts a temperature sensor as input. It compares the actual temperature to the desired control temperature, or set point, and provides an output to a control element. An on-off controller will switch the output only when the temperature crosses set point. For heating control, the output is on when the temperature is below the set point, and off above set point. Since the temperature crosses the set point to change the output state, the process temperature will be cycling continually, going from below set point to above, and back below.
3.7.2 How to prevent the output from frequently changes according to minute temperature changes

ON/OFF control action turns the output ON or OFF based on the set point. The output frequently changes according to minute temperature changes as a result, and this shortens the life of the output relay or unfavorably affects some devices connected to the Temperature Controller. To prevent this from happening, a temperature band called hysteresis is created between the ON and OFF operations.

In cases where this cycling occurs rapidly, and to prevent damage to contactors and valves, an on-off differential, or “hysteresis,” is added to the controller operations. This differential requires that the temperature exceed set point by a certain amount before the output will turn off or on again.

![Diagram showing the concept of hysteresis in temperature control](image)

Figure 13 how does smart thermostat, alarm system works?

![Diagram showing the concept of hysteresis in temperature control](image)

Figure 14 The example of configuration. Sera2 > Automation/ Sensors. Double click on the selected line.

⚠️ Max Value hysteresis is the same hysteresis for Output activation and for alarm event.
3.7.3 The example of heating, cooling control with the module GTalarm2

The module activates the output at the set point. The event recovers from the hysteresis value.

Temperature 28 degrees – OUT1 will be activate after 1000ms. Max Alarm Event Delay prevents from OUT1 activation in response to short-term temperature fluctuations, for example because of window or door opening.

Temperature 30 degrees – alarm SMS with the text “Max Value” will be send after 10000ms

If the hysteresis set to 1. The system will work as follows:
Set point = 28 degrees
When temperature rise to 28 degrees, turn on the cooler. When temperature drops to 27 degrees, the system will turn off the cooler.

ON-OFF control switches the output either full ON or full OFF, depending on the input set point and hysteresis values. The hysteresis value indicates the amount the process value must deviate from the set point to turn on the output. With hysteresis set to 0, the process value would stay closer to the set point, but the output would switch ON and OFF more frequently, and may result in the output “chattering”.

In order to control big power alternating current equipment, it is comfortable to use solid state relays.

AC/DC adapter with the voltage 10V - 14V and current >=1A might be used to powering the module. We recommend to use TPS12 power supply with the deep discharge protection. The solution with GTalarm2 module will gives a call and send SMS warning when the battery voltage reaches the limit.

https://www.topkodas.lt/Downloads/GTalarm2_TPS12_AN_EN.pdf
3.7.4 Change the room temperature remotely via mobile, web app

Up to 32 app based thermostats in one module – allow to control a thermostat using mobile, web app. Module GTalarm2 will let control, change the room temperature remotely.

![Figure 17 the example how to control heating or cooling device with the module GTalarm2](image)

Please refer to the "Android, web app” user manual: [https://www.topkodas.lt/Downloads/GTalarm2_App_AN_EN.pdf](https://www.topkodas.lt/Downloads/GTalarm2_App_AN_EN.pdf)

3.7.5 Change the room temperature with SMS text messages

This application is useful when the area where the controller located is in a cellphone service, but there is no internet access. For example: the cabin in the mountains. This solution will allow to send an SMS/text message to remotely turn up the thermostat, ahead of time, so that it's warm when the customer will arrive.
Commands can be given in two different ways: the first one is to send the SMS according to required syntax and with the password (if required), needful to avoid strangers to operate the configuration.

Multiple temperature sensors. It is possible to connect up to 32 temperature sensors to the module GTalarm2.

Temperature-humidity sensor. The same sensor can measure temperature and humidity.

Heating control. It is possible to switch ON or OFF heating device.

<table>
<thead>
<tr>
<th>Command Code</th>
<th>Description</th>
<th>Syntax</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>070</td>
<td>Programming of max sensors value upon reaching, the SMS message with „High Alarm“ text will be sent.</td>
<td></td>
<td>N = sensor number; VALUE = Format 0000.00 High Alarm Value</td>
</tr>
<tr>
<td>071</td>
<td>Programming of minimal sensors value upon reaching the SMS message with „Low Alarm“ text will be sent.</td>
<td></td>
<td>N = sensor number; VALUE = Format 0000.00 Low Alarm Value</td>
</tr>
<tr>
<td>072</td>
<td>Programming of sensor max value upon reaching the selected output will be activated.</td>
<td></td>
<td>N = sensor number; VALUE = Format 0000.00 Sensor max value upon reaching, the selected output will be activated.</td>
</tr>
<tr>
<td>073</td>
<td>Programming of sensor min value upon reaching the selected output will be activated.</td>
<td></td>
<td>N = sensor number; VALUE = Format 0000.00 Sensor min value upon reaching which, the output will be activated.</td>
</tr>
</tbody>
</table>
4 Sensors. Inputs.

4.1 Steps to start humidity sensors DHT22/AM2305/AM2306/AM2320/AM2321

Module should work with following sensors: Aosong 1-Wire bus Humidity Sensor DHT22, AM2305, AM2306. Also a new smaller sensor exists AM2320 & AM2321.

Table 2 Sensors AM2320/AM2321 specification

<table>
<thead>
<tr>
<th>Manufacturers’ Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM2320/AM2321</td>
</tr>
<tr>
<td>Operating Range</td>
</tr>
<tr>
<td>Absolute accuracy (%RH, 25°C)</td>
</tr>
<tr>
<td>Repeatability (%)</td>
</tr>
<tr>
<td>Long term stability (% per year)</td>
</tr>
<tr>
<td>1/e Response (sec)</td>
</tr>
<tr>
<td>Voltage supply (V)</td>
</tr>
</tbody>
</table>

The table lists values taken from datasheets. The Aosong data sheets do not specify maximum tolerances for most parameters, just "typical" values. It would therefore seem that any particular device is not guaranteed to meet these specifications. For all the other devices the numbers above are the maximum tolerances and most also offer better "typical" specifications.

Each AM2320 sensor connects on separate bus line to digital inputs (D1, D2, and D3). Total up to 3 AM2320 Aosong (Guangzhou) humidity sensors can be connected to GTalarm2.

Steps to start AM2320 sensors:
1. Connect AM2320 to D1, D2, D3 according connection diagram.
2. Sensor’s type should be select in the System Options> Digital I/O Settings window. Set digital input definition D1, D2, D3 to Aosong 1 Wire bus Humidity Sensor AM2320
3. Write configuration
4. Power module.
5. After module starts , read configuration
6. Go to "Automation/ Sensors" window in the SERA2 software
7. Double click on the selected sensor’s line.
8. Click on “Sensor type/ hardware location” and default sensor settings appear.
9. In sensors table column Sensor HW ID find registered sensors AM2320 looks like “GTalarm, Input D1, 1-Wire, AM2320 Humidity, 28AE51560500” Location of the sensor can be changed choosing wanted sensor in the list
10. Double click on the sensor row opens selected sensor window
11. Set other parameters of the sensor MIN, MAX values Units etc.
12. Write configuration to module
14. Go to RT Testing&Monitoring Window > Event Monitoring TAB. Software will show real time sensor values, and alarm states
15. If you need to receive SMS with sensors alarm, go to GSM communication> SMS/ DIAL Reporting window
16. Enter telephone numbers of users and mark alarm events that you want to receive. Open "Reporting SMS&DIAL" window. Set user phone number, and choose reporting option Sensor1 - Sensor32 Alarm/Restore. Module will send SMS to user in case of sensor alarm event
17. Write configuration

![AM2320 connecting diagram]

Do not reverse the polarity
4.1.1 Humidity sensor watchdog

The sensor restarts when the system recognizes sensors not being processed for some time. If the sensor will not communicate with the module more than the programmed time (for example 2min), the system will reset the sensor. It is the way to ensure the stable work of the system, because the sensor will be reset if needed. For this purpose any of OUT1-OUT4 can be used.

The output should be configured as sensor reset:
Go to “Outputs” window.
Set “Out definition” to “RH Sensor trouble”, “Mode” – “Steady”.

4.2 Steps to start analog sensors, connected to the inputs 0-10V, 0-20mA, 4-20mA

Step by step to start analog sensors:
1. Connect analog voltage sensors to In1, In2, In3 and connect analog current sensors to I/O1, I/O2 according connection diagram.
2. Security system sensors, could be used in the system, if required.
3. If security system sensors is not in use, the inputs should be disabled in “Zones” window.
4. Analog sensors should be calibrated in the Automation/Sensors window. Double click on the selected sensor’s line. Analog sensors could be selected from the default list. Units could be changed. Sensors calibration is possible by changing multiplier, offset.
5. When all changes have been done, the configuration should be written, by pressing “Write” icon.
7. Go to RT Testing & Monitoring Window > Event Monitoring TAB. Software will show real time sensor values, and alarm states.
8. If you need to receive SMS with sensors alarm, go to GSM communication > SMS/DIAL Reporting window. Enter telephone numbers of users and mark alarm events that you want to receive. Open “Reporting SMS/DIAL” window. Set user phone number, and choose reporting option Alarm/Restore. Module will send SMS to user then sensor alarm event occurs.
9. Write configuration.

There is the possibility to convert Celsius to Fahrenheit or vice versa, or calibrate the sensors measuring.

Two point is the simplest as the equation is \( y = mx + c \). It is the equation of a straight line, the graph of a linear sensor. \( Y \) is the output value, \( m \) is the multiplier otherwise known as the slope or gradient and \( c \) is the offset. \( X \) is the input value.

Go to “Automation/ Sensors” window and double click on the selected sensor’s line.
4.3 Steps to start temperature sensors DS18b20.

Do not reverse the polarity

The DS18b20 digital thermometer provides 12-bit Celsius temperature measurements. The DS18b20 communicates over a 1-Wire. Each DS18b20 has a unique 64-bit serial code, which allows multiple DS18b20s to function on the same 1-Wire bus. Thus, it is simple to use one to control many DS18b20s distributed over a large area. Applications that can benefit from this feature include HVAC environmental controls, temperature monitoring systems inside buildings, equipment, or machinery, and process monitoring and control systems.

Applications/Uses
- Consumer Products
- Industrial Systems
- Thermally Sensitive Systems
- Thermometers
- Thermostatic Controls

Key Features
- Measures Temperatures from -55°C to +125°C (-67°F to +257°F)
- ±0.5°C Accuracy from -10°C to +85°C
- Each Device Has a Unique 64-Bit

1. Connect 1-Wire sensors DS18b20 to D1, D2, D3 according to the connection diagram.

2. If you need to connect more sensors to the same input, connect them as a star. In order to compensate line impedances, each line should be separated by 82-120 Ohm resistors.

The resistor must be as close as possible to the contacts of the module GTalarm2.
usually fit into a few generalized categories, based on the distribution of the sensor. As a rule, the designer should use one twisted pair, for example blue/blue-white. A single wire from another pair is used for the 3.3 volt supply.

3. Sensor’s type should be select in the System Options> Digital I/O Settings window. Set digital input definition D1, D2, D3 to Dallas 1-Wire Bus option.
4. Write configuration by pressing write icon.
5. Power module.
6. After module starts , read configuration
7. Go to “Automation/ Sensors” window in the SERA2 software
8. Double click on the selected sensor’s line.
9. Click on “Sensor type/ hardware location” and default sensor settings appear. In sensors table column Sensor HW ID find registered sensors DS18b20 looks like “GTalarm2, Input D1, 1-Wire, DS18B20 Temperature, SN:28AE5156000” Location of the sensor can be changed choosing wanted sensor in the list.
10. Double click on the sensor row opens selected sensor window. Set other parameters of the sensor MIN, MAX values Units etc.
11. Write configuration to module
13. Go to RT Testing&Monitoring Window > Event Monitoring TAB. Software will show real time sensor values, and alarm states
14. If you need to receive SMS with sensors alarm, go to GSM Communications > SMS DIAL Reporting window. Enter telephone numbers of users and
15. Mark alarm events that you want to receive. Open “Reporting SMS&DIAL” window. Set user phone number, and choose reporting option Sensor1 - Sensor32 Alarm/Restore. Module will send SMS to user then sensor alarm event occurs
16. Write configuration

How to identify sensors, connected to the inputs?

Sensors could be connected one by one and write the serial number and the name of the sensor. Each sensor has a name, it is entered in SERA2 in the “Automation / Sensors” window.

If all sensors connect at the same time, they will be registered in random way. If the sensors are connected to the star and if you want to know where the sensor is, then you can raise the temperature of the one sensor and see where the sensor is located. Let’s say, the temperature of one sensor is raised to 20. Look to the Sera2> RT Testing&Monitoring> Sensors/Automation window and you will see all sensor settings appear. In sensors table column Sensor HW ID find registered sensors DS18b20 looks like “GTalarm2, Input D1, 1-Wire, DS18B20 Temperature, SN:28AE5156000” Location of the sensor can be changed choosing wanted sensor in the list.

1-Wire Network Topologies

1-Wire networks are often quite “free form” in structure, they usually fit into a few generalized categories, based on the distribution of the 1-Wire slaves and the organization of the interconnecting wires.

- Linear topology. The 1-Wire bus is a single pair, starting from the master and extending to the farthest slave device. Other slaves are attached to the 1-Wire bus with insignificant (< 3m) branches or “stubs.”
- Stubbed topology. The 1-Wire bus is a single main line, starting at the master and extending to the farthest slave. Other slaves are attached to the main line through branches or stubs 3m or more in length.
- Star topology: The 1-Wire bus is split at or near the master end and extends in multiple branches of varying lengths. There are slave devices along, or at the ends of, the branches.

When different topologies are intermixed, it becomes much more difficult to determine the effective limitations for the network. As a rule, the designer should apply the most conservative of the criteria in these cases.

Using cat 5 cable is best and will make it easier to maintain a working 1-wire network when you expand and add more sensors. The data and ground should use one twisted pair, for example blue/blue-white. A single wire from another pair is used for the 3.3 volt supply.
Don't double up wires on the assumption that this lowers resistance and is a 'good thing', it actually alters the impedance of the network and makes it less reliable. All unused wires in the cat 5 cable should be left unconnected (don't connect them to ground). When running a 1-Wire bus, Dallas recommend that you use an unshielded Cat5 cable for the bus. Do not use shielded cable as the capacitance increase will upset the network.

If you intend to have a large 1-Wire network, it is important that you design the network correctly, otherwise you will have problems with timing/reflection issues and loss of data. You must connect each sensor to a single continuous cable which loops from sensor to sensor in turn (daisy chain). This will reduce potential miss-reads due to reflections in the cable. Each sensor should have a maximum of 50mm (2") of cable connected off this main network.

Even when using this method, connecting more than 10-15 sensors will still cause problems due to loading of the data bus. To minimize this effect, place a 100-120Ω resistor in series in the data line of each sensor before connecting to the network. The total length of the bus from 10 to 100m. Depending of cable quality sensors number on bus, and environment noise. There is possibility to connect up to 32 devices.

If 1 or 2 temperature sensors connected to the module GTalarm2 resistors are not required. However, if the sensors are combined with different topologies, separation of 82-120Ohm resistors is required. Different topologies must be separated through 82-120Ohm resistors. The resistors must be connected as close as possible to the contacts of the module GTalarm2.

If the sensors do not work properly, noise is generated, we recommend connect 470-2000uF capacitors as showed in the figure below. The capacitor is connected at the end of the line as close as possible to the sensor.

Begin the installation by mounting additional devices in the cabinet using the stand-offs provided, then mount the cabinet in a dry, protected area with access to unstitched AC power. Install hardware in the sequence indicated in the following pages. Do NOT apply power until installation is complete.

Minimum ¼" (6.4mm) separation must be maintained at all points between power limited and non-power limited wiring and connections.

5 How to identify sensors, connected to the inputs?

1. You can connect sensors one by one and write the serial number and the name of the sensor. Each sensor has a name, it is entered in SERA2 in the "Automation / Sensors" window.

2. If you connect all sensors at the same time, they will be registered in random way. If the sensors are connected to the star and if you want to know where the sensor is, then you can raise the temperature of the one sensor and see where the sensor is located. Let's say, the temperature of all sensors is 10 degrees, the temperature of one sensor is raised to 20. Look to the monitoring window and you will see where the sensor is.
6 Low and high alarm threshold settings. Output activation.

Sera2> Automation/ Sensors. (Double click on the line)

<table>
<thead>
<tr>
<th>Sensor Name</th>
<th>Val</th>
<th>H</th>
<th>L</th>
<th>HOut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home office</td>
<td>9.31°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Boiler room</td>
<td>7.94°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Porch</td>
<td>8.94°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>WC RH</td>
<td>42.70%</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>WC Temp</td>
<td>9.90°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Living Room</td>
<td>9.88°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Garage</td>
<td>4.44°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Bedroom 2nd fl</td>
<td>8.50°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Kids Bedroom 1</td>
<td>6.69°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Kids Bedroom 2</td>
<td>7.25°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Bathroom 2A RH</td>
<td>39.80%</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Bathroom 2A Temp</td>
<td>9.90°C</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Figure 31 Sera2> RT Testing & Monitoring > Sensors/ Automation

Figure 32 Sera Cloud Android App
If Digital inputs D1, D2, D3 are used, then
1. go to System Options> Digital I/O Settings and select required parameters
2. Press “Write” in the command line.
3. Power the module
4. Press “Read” in the command line
5. Go to Automation/ Sensors window
6. Select the sensor
7. Set High/ Max Value Action Settings
8. Set Low/Min Value Action Settings.

More information:
4.1 Steps to start humidity sensors DHT22/AM2305/AM2306/AM2320/AM2321
4.3 Steps to start temperature sensors DS18b20.

If In1…In4 or I/O1…I/O2 inputs are used then
1. Go straight to the Automation/ Sensors window.
2. Select the sensor
3. Set High/ Max Value Action Settings
4. Set Low/Min Value Action Settings.

More information:
4.2 Steps to start analog sensors, connected to the inputs 0-10V, 0-20mA, 4-20mA

Temperature 28 degrees (Max Value To Activate Output)
OUT1 (Output) will be activated after 1000ms (Max Value Output Control Delay)
Temperature 30 degrees (Max Value Alarm Event/ SMS)– alarm SMS
With the text “Max Value” (Alarm Event SMS Text)
Will be send after 10000ms (Max Alarm Event Delay)
Max Value Hysteresis=1
When temperature rise to 28 degrees, turn on the cooler
When temperature drops to 27 (28-1) degrees, the system will turn off the cooler.

5. When all changes has been done, the configuration should be written, by pressing write icon.
7. Go to RT Testing&Monitoring Window > Event Monitoring TAB, Software will show real time sensor values, and alarm states
8. If you need to receive SMS with sensors alarm, go to GSM communication > SMS/ DIAL Reporting window. Enter telephone numbers of users and mark alarm events that you want to receive. Open "Reporting SMS&DIAL" window. Set user phone number, and choose reporting option Alarm/Restore. Module will send SMS to user then sensor alarm event occurs
9. Write configuration

7 Every field explanation in Sera2> Automation/ Sensors window

Double click on the selected sensor’s line will show selected sensor’s configuration window.

Figure 33 the example of Automation/Sensors (Automation/Sensors/Analog Inputs) window

For example double click on “Sensor Name 1” line will show “Sensor 1 Settings” window. The required parameters of the sensor 1 can be set in that window.
Figure 34 The example of Automation/Sensors (Automation/Sensors/Analog Inputs) window

Table 3 Explanation of every field in "Automation/ Sensors" window

<table>
<thead>
<tr>
<th>No.</th>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sensor Name</td>
<td>Sensor name</td>
</tr>
<tr>
<td>2</td>
<td>Sensor Type/ Hardware location</td>
<td>Sensor Hardware ID</td>
</tr>
<tr>
<td>3</td>
<td>Sensor Enabled/ Disabled</td>
<td>Sensor disabled</td>
</tr>
<tr>
<td>4</td>
<td>Max/Min Value Action Settings</td>
<td>Select the sensor type hardware location</td>
</tr>
<tr>
<td>5</td>
<td>Max/Min Value Alarm Event/ SMS</td>
<td>Location of sensor connected to the module. Select connected sensors</td>
</tr>
<tr>
<td>6</td>
<td>Max/Min Value To Activate Output</td>
<td>Sensor name</td>
</tr>
<tr>
<td>7</td>
<td>Max/Min Value Hysteresis</td>
<td>Sensor disabled</td>
</tr>
<tr>
<td>8</td>
<td>Max/Min Value Output Control Delay</td>
<td>Sensor Hardware ID</td>
</tr>
<tr>
<td>9</td>
<td>Contact ID Report Code</td>
<td>Report Contact ID code</td>
</tr>
<tr>
<td>10</td>
<td>Alarm Event SMS Text</td>
<td>Text, which will be visible in SMS message in case of set temperature excess, is entered</td>
</tr>
<tr>
<td>11</td>
<td>Enable Alarm Event/ SMS</td>
<td>The indicated report will be sent when it is checked.</td>
</tr>
<tr>
<td>12</td>
<td>Min Value Alarm Event/ SMS</td>
<td>Minimum allowable temperature value, which will be reported.</td>
</tr>
<tr>
<td>13</td>
<td>Min Value To Activate Output</td>
<td>Minimum allowable temperature value, which will activate the selected output</td>
</tr>
<tr>
<td>14</td>
<td>Min Value Hysteresis</td>
<td>Temperature hysteresis value is indicated.</td>
</tr>
<tr>
<td>15</td>
<td>Min Value Output Control Delay</td>
<td>The output which will be activated, when the minimum allowable temperature value will be reached</td>
</tr>
<tr>
<td>16</td>
<td>Contact ID Report Code</td>
<td>Report Contact ID code</td>
</tr>
<tr>
<td>17</td>
<td>Alarm Event SMS Text</td>
<td>Text, which will be visible in SMS message in case of set temperature excess, is entered</td>
</tr>
<tr>
<td>18</td>
<td>Enable Alarm Event/ SMS</td>
<td>The indicated report will be sent when it is checked.</td>
</tr>
<tr>
<td>19</td>
<td>Min Value Alarm Event/ SMS</td>
<td>Minimum allowable temperature value, which will be reported.</td>
</tr>
<tr>
<td>20</td>
<td>Min Value To Activate Output</td>
<td>Minimum allowable temperature value, which will activate the selected output</td>
</tr>
<tr>
<td>21</td>
<td>Min Value Hysteresis</td>
<td>Temperature hysteresis value is indicated.</td>
</tr>
<tr>
<td>22</td>
<td>Min Value Output Control Delay</td>
<td>The output which will be activated, when the minimum allowable temperature value will be reached</td>
</tr>
<tr>
<td>23</td>
<td>Max/Min Value Action Settings</td>
<td>Select the sensor type hardware location</td>
</tr>
<tr>
<td>24</td>
<td>Max/Min Value Alarm Event/ SMS</td>
<td>Location of sensor connected to the module. Select connected sensors</td>
</tr>
<tr>
<td>25</td>
<td>Max/Min Value To Activate Output</td>
<td>Sensor name</td>
</tr>
<tr>
<td>26</td>
<td>Max/Min Value Hysteresis</td>
<td>Sensor disabled</td>
</tr>
<tr>
<td>27</td>
<td>Max/Min Value Output Control Delay</td>
<td>Sensor Hardware ID</td>
</tr>
</tbody>
</table>
8 How to calibrate the sensor

Following the equation Temperature=X*ADC+Y, selecting X and Y coefficients.

1. Go to Sera2 software, Automation/ Sensors window, double clicked on the selected sensors line.
2. Measure temperature at least in two points with the accurate thermometer.
3. Read temperature ADC indications at these points in the “RT Testing & Monitoring” > “Sensors/ Automation” window.
4. Following the equation “Temperature=X*ADC+Y” to calculate X and Y coefficients. Calculated X and Y coefficients should be programmed in the module. It is easy to calculate X and Y coefficients in MC Excel by using trend line.

9 How to convert Celsius to Kelvin or Celsius to Fahrenheit

Sensor Calibration area in Sera2> Automation/ Sensors (double click on the sensor's line)

1. Go to Sera2> Automation/ Sensors (double click on the sensor's line).
2. Enter Y (offset) and X (multiplier) values.
3. Change the units to Kelvin or Fahrenheit in the Sera2> Automation/ Sensors (double click on the sensor's line).

Celsius to Fahrenheit conversion
Y(offset)=32, X(multiplier)=1.8

Celsius to Kelvin conversion
Y(offset)=273.15, X(multiplier)=1
10 Outputs.

Ser2> Outputs (PGM)

GTalarm2 comes equipped with four open-collector PGM outputs allowing to connect up to four devices or relays. Also GTalarm2 comes with two programmable 20mA outputs, three 10 mA and max voltage 3.3V outputs, and with one 20mA programmable output BUS.

If the output is not in use, it should be disabled. Once a PGM output is disabled, it can no longer be turned ON or OFF unless it is enabled again. It is possible to instantly turn ON an individual PGM output for a determined time period and automatically turn it OFF when the time period expires. When the PGM output is turned ON or OFF, the system will send a confirmation by SMS text message to the user phone number.

The automatic action of the determined PGM output can be set as follows:

- Turn ON – Determines whether the PGM output is to be turned ON.
- Turn OFF – Determines whether the PGM output is to be turned OFF.
- Pulse – Determines whether the PGM output is to be turned ON or OFF for a set period of time in seconds based on the PGM output startup state set up.

The PGM output can be automatically activated under the following events:

- System armed or disarmed
- Alarm begins or stops
- Zone violated, or restored.

The user can also set a custom text, which will be sent by SMS text message to user phone number when the automatic PGM output action is carried out.

1. Install SERA2 software.
2. Connect the module to the computer via mini USB cable.
3. Go to Outputs (PGM) window in the SERA2 software.
4. Parameters of the selected output should be set:
5. Output operation description (OUT definition): disable, bell, buzzer, flash, system state, ready, automation/CTRL, AC OK, battery OK, ARM/DISARM, alarm indication, lost primary channel, lost secondary channel, fire sensor, RH sensor trouble.
7. If necessary output operation might be inverted.
8. Write configuration by pressing write icon.

8. Outputs can be controlled only in Automation/CTRL mode.
9. If you need to control outputs by short call or SMS, go to “Users & Remote Control” window and enter telephone numbers of users, who will be able to control selected outputs via free short call.
10. Write configuration by pressing write icon.

For sound and visual signaling, please refer to Fire and Security application note.

- In order to control big power alternating current equipment, it is comfortable to use solid state relays.
- Standard AC/DC adapter with the voltage 10V-14V and current >=1A might be used to powering the module.

![Fig. 1 Relay connection to OUT1-OUT4, I/O1, I/O2 20mA](image1)

![Figure 37 The example of Outputs window](image2)
Table 5 Explanation of every field in “Outputs” window

<table>
<thead>
<tr>
<th>No.</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID</td>
<td>Output sequence number.</td>
</tr>
<tr>
<td>2</td>
<td>Output Location in Hardware</td>
<td>The outputs hardware location.</td>
</tr>
<tr>
<td>3</td>
<td>Output Label</td>
<td>Output name</td>
</tr>
<tr>
<td>4</td>
<td>Out definition</td>
<td>Selection of output operation mode.</td>
</tr>
<tr>
<td>5</td>
<td>Mode</td>
<td>Output control mode.</td>
</tr>
<tr>
<td>6</td>
<td>Out Timer</td>
<td>Pulse time duration can be from 1 to 999999 sec.</td>
</tr>
<tr>
<td>7</td>
<td>Invert</td>
<td>Inversion is activated</td>
</tr>
<tr>
<td>8</td>
<td>Pulsating</td>
<td>Pulsating mode is activated. Then output is activated it will pulsate according pulse ON/OFF time.</td>
</tr>
<tr>
<td>9</td>
<td>Pulse ON Time</td>
<td>Pulsating mode pulse ON duration.</td>
</tr>
<tr>
<td>10</td>
<td>Pulse OFF Time</td>
<td>Pulsating mode pulse OFF duration.</td>
</tr>
</tbody>
</table>

Outputs can be set as timers.

1. When output is activated for “Out Timer” time interval,
2. Relay contact start changing state from ON (pulse time ON) to OFF (Pulse time Off)
3. This cycle will repeat until output is deactivated.

11 Power loss alarms.

If power loss, or other troubles should generate alarm to the users, please refer to the Fire and Security application note.

12 Alarm events such as open doors

If operational events such as door opening may also need to be logged and recorded, please look to the fire and security system’s application note. This information is useful because operational events (for example door opening in freezer rooms and cold rooms) can have a significant impact on environmental control.

13 Remote monitoring, control, configuring, FW updating over the internet

If remote monitoring, control, configuring, FW updating over the internet is needed please refer to the “Remote monitoring via Linux Server” application note.

14 General system configuration

**Sera2> System Options> General System Options**

The system comes equipped with internal real-time clock (RTC) with battery that keeps track of the current date and time. Once the system is up and running, the user must set the correct date and time, otherwise the system will not operate properly. SERA2 software provides the ability to select the Time Zone and the user may also choose Set module time from PC, which instantly provides the exact PC time. When the system is connected to the monitoring station via IP connection the date and time will be automatically synchronized with the monitoring station.

If the module has been connected first time to the power supply, or power supply has been disconnected for a long time, the time of the module should be set again.

The module can send a trouble report and restrict arming if some of selected troubles [Restrict ARM] exist during close event.
Figure 38: The example of System Options > General System Options window.

**Table 6: Explanation of every field in “General System Options” window**

<table>
<thead>
<tr>
<th></th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Object Name</td>
<td>Object Name. It allows you to enter programming mode, where you can program all features, options, and commands of the module.</td>
</tr>
<tr>
<td>2</td>
<td>SIM Card PIN</td>
<td>SIM card PIN code. Default 1234. This password allows you to enter programming mode, where you can program all features, options, and commands of the module.</td>
</tr>
<tr>
<td>3</td>
<td>Installer Password</td>
<td>The default installer password is <strong>000000</strong>. This password allows you to enter programming mode, where you can program all features, options, and commands of the module.</td>
</tr>
<tr>
<td>4</td>
<td>SMS User Password</td>
<td>The default SMS User Password is <strong>123456</strong>. This code allows you to utilize arming method, as well as program user codes.</td>
</tr>
<tr>
<td>5</td>
<td>User Access Code Format</td>
<td>A 4-digit or 6-digit user access code format can be selected.</td>
</tr>
<tr>
<td>6</td>
<td>I/O1 Settings</td>
<td>2-Wire Smoke detector (Fire current loop) or 0-10V Analog Input (Zone or Sensor) or Output or – 0-20mA, 4-20mA Current Loop Sensor could be assigned to the I/O1</td>
</tr>
<tr>
<td>7</td>
<td>I/O2 Settings</td>
<td>2-Wire Smoke detector (Fire current loop) or 0-10V Analog Input (Zone or Sensor) or Output or – 0-20mA, 4-20mA Current Loop Sensor could be assigned to the I/O2</td>
</tr>
<tr>
<td>8</td>
<td>0-10V Analog Input (Zone or Sensor)</td>
<td>0-10V Analog sensors will be connected to the input.</td>
</tr>
<tr>
<td>9</td>
<td>Output</td>
<td>Input will be used as output.</td>
</tr>
<tr>
<td>10</td>
<td>2-Wire Smoke Detector (Fire current loop)</td>
<td>2-Wire Smoke detectors will be connected to the input.</td>
</tr>
<tr>
<td>11</td>
<td>0-20mA, 4-20mA Current Loop Sensor</td>
<td>0-20mA, 4-20mA Current Loop Sensors will be connected to the input.</td>
</tr>
<tr>
<td>12</td>
<td>Clear Event Buffer After Reset</td>
<td>When the cell is checked, the memory of unsent reports will be deleted after the module resetting.</td>
</tr>
<tr>
<td>13</td>
<td>Set module time from PC</td>
<td>To set the clock click Set time from PC button and the clock will be set using computer’s clock.</td>
</tr>
<tr>
<td>14</td>
<td>Read module time</td>
<td>To read the clock of panel.</td>
</tr>
<tr>
<td>15</td>
<td>PC Time</td>
<td>PC Time</td>
</tr>
<tr>
<td>16</td>
<td>Panel Time</td>
<td>Panel Time</td>
</tr>
<tr>
<td>17</td>
<td>Reset Device</td>
<td>Reset module command</td>
</tr>
</tbody>
</table>
15 Logging events

Sera2> Events Log

The Event Log window shows real-time information of the events that have occurred. Every enabled new event is stored in log. Internal event log has some limitations. It is possible to store 2048 events in the events log buffer. Events could be saved to the file. If you need to store more events, you can use Sera cloud server. The user is able to see every event remotely via web app.

The event log allows to chronologically register up to 2048 time-stamped records regarding the following system events:

- System start.
- System arming/disarming.
- Zone violated/restored.
- Temperature deviation by MIN and MAX boundaries.
- Configuration via USB.

Table 5 explains every field in the Events Log window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Event Log</td>
<td>Events could be read from the module by clicking Read Event Log button</td>
</tr>
<tr>
<td>Clear Event Log</td>
<td>Events could be cleared from the module by clicking Clear Event Log button</td>
</tr>
<tr>
<td>Event Number</td>
<td>Event sequence number</td>
</tr>
<tr>
<td>Event</td>
<td>Object number and registered event report in Contact ID code.</td>
</tr>
<tr>
<td>Time</td>
<td>Event date and time.</td>
</tr>
<tr>
<td>Note</td>
<td>Event report text which was indicated.</td>
</tr>
</tbody>
</table>

15.1 Event monitoring

Sera2> RT Testing & Monitoring> Event Monitoring

The following information is displayed:

<table>
<thead>
<tr>
<th>Event number</th>
<th>Contact ID Code</th>
<th>Event date and time</th>
<th>Event report text which was indicated</th>
</tr>
</thead>
</table>
15.2 Monitoring Inputs, outputs & general system info

Sera2> RT Testing & Monitoring> Hardware

RT „Testing & Monitoring” window „Hardware” tab enables you to view and test the current status of each input, output

![Image](image.png)

Figure 42 The example of RT Testing & Monitoring > Hardware window

Table 9 Explanation of every field in "Hardware" window

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start Monitoring</td>
<td>Pressing Start Monitoring button starts the monitoring of the module.</td>
</tr>
<tr>
<td>2</td>
<td>Stop Monitoring</td>
<td>Pressing Stop Monitoring button stops the monitoring of the module.</td>
</tr>
<tr>
<td>3</td>
<td>IMEI</td>
<td>IMEI number of GSM modem available in the module</td>
</tr>
<tr>
<td>4</td>
<td>SIM ICCID</td>
<td>ICCID (Integrated Circuit Card Identifier) - A SIM card contains its unique serial number (ICCID). ICCIDs are stored in the SIM cards and are also printed on the SIM card.</td>
</tr>
<tr>
<td>5</td>
<td>SIM Card</td>
<td>If note READY is visible, it means that SIM card is fully functioning. Otherwise, check whether PIN code request is off or replace SIM card.</td>
</tr>
<tr>
<td>6</td>
<td>Signal level</td>
<td>Signal strength of GSM communication</td>
</tr>
<tr>
<td>7</td>
<td>Registration</td>
<td>State of GSM modem registration to GSM network.</td>
</tr>
<tr>
<td>8</td>
<td>SMS Service Centre Address</td>
<td>SMS center number. This number should be checked if it is correct. If this number is incorrect, SMS messaging may be impossible. This number may be changed after inserting SIM card into any mobile phone.</td>
</tr>
<tr>
<td>9</td>
<td>System Voltage</td>
<td>Power supply voltage. Nearby number is value of ADC voltage. When multiplying this number by the coefficient Fig. 32, voltage value (V) will be achieved.</td>
</tr>
<tr>
<td>10</td>
<td>System Voltage</td>
<td>System voltage OK/Trouble</td>
</tr>
<tr>
<td>11</td>
<td>RTC Clock</td>
<td>Real time clock OK/Trouble</td>
</tr>
<tr>
<td>12</td>
<td>Module Real Time Clock</td>
<td>Indicates the time of the module RTC</td>
</tr>
<tr>
<td>13</td>
<td>Set RTC Clock</td>
<td>By pressing this button real time clock of the module will be set.</td>
</tr>
<tr>
<td>14</td>
<td>Inputs In1…In4</td>
<td>In1…In4 is the indicated input ADC and voltage value V.</td>
</tr>
<tr>
<td>15</td>
<td>I/O1…/O2</td>
<td>I/O1…/O2 is the indicated voltage ADC value and current ADC value mA.</td>
</tr>
<tr>
<td>16</td>
<td>D1…D3 (I/O)</td>
<td>Check box nearby the digital inputs D1…D3 (I/O) means that the input has ‘0’ or ‘1’ state.</td>
</tr>
<tr>
<td>17</td>
<td>BUS (I/O)</td>
<td>Check box nearby the programmable output BUS (I/O) means that the input has ‘0’ or ‘1’ state.</td>
</tr>
<tr>
<td>18</td>
<td>Out1…Out4 On/Off</td>
<td>Checked box nearby the appropriate output Out1…Out4 means that this output currently has ‘0’ or ‘1’ state. The output could be activated by pressing On/Off button</td>
</tr>
<tr>
<td>19</td>
<td>I/O1…/O2 On/Off</td>
<td>Checked box nearby the appropriate input/output I/O1…/O2 means that this input/output currently has ‘0’ or ‘1’ state. The output could be activated by pressing On/Off button</td>
</tr>
<tr>
<td>20</td>
<td>D1…D3 (I/O) On/Off</td>
<td>Checked check box nearby the digital outputs D1…D3 (I/O) means that the output currently has ‘0’ or ‘1’ state.</td>
</tr>
<tr>
<td>21</td>
<td>BUS (I/O) On/Off</td>
<td>Checked check box BUS (I/O) means that the output currently has ‘0’ or ‘1’ state.</td>
</tr>
</tbody>
</table>
15.3 Realtime Testing & Monitoring > Sensors/ Automation

Figure 43 the example of RT Testing & Monitoring > Sensors/ Automation window

Table 10 Explanation of every field in "Sensors/ Automation" window

<table>
<thead>
<tr>
<th></th>
<th>Sensor1…Sensor32</th>
<th>Sensor number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Value</td>
<td>The value of sensor's voltage</td>
</tr>
<tr>
<td>2</td>
<td>Active</td>
<td>If checked and the color is green, the sensor is active</td>
</tr>
<tr>
<td>3</td>
<td>High Val Alarm</td>
<td>If checked and the color is red, the high value alarm is generated</td>
</tr>
<tr>
<td>4</td>
<td>Low Val Alarm</td>
<td>If checked and the color is red, the low value alarm is generated</td>
</tr>
</tbody>
</table>